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Disclaimer

The information in this document is provided solely in connection with the product and a reasonable
effort has been made to have it accurate and reliable, however, we do not assume any liability
whatsoever for the accuracy and completeness of the above information. The manufacturer reserves
the right to make changes, corrections, modifications or improvements to this document, and to the
products and services described herein, at any time and without notice. No representations or
warranties, either express or implied, of merchantability, fitness for a particular purpose or of any other
nature are made hereunder with respect to information/specification or the products to which
information refers and no guarantee with respect to compliance to the intended use is given. In
particular, this also applies to the stated possible applications or areas of applications of the product.

The customers are responsible for the appropriate, safe and legal use, processing and handling of our
products.

Manufacturer
This product is manufactured in Italy by Eoptis Srl.

Life-support policy

The product is not designed for use in life-support appliances, devices or systems where malfunction
of these products can reasonably be expected to result in personal injury. Customers using or selling
these products for use in such applications do so at their own risk, and agree to fully indemnify the
manufacturer for any damages resulting from such improper use or sale.

Copyright, Trademarks and IP

All of the materials in this document are protected by copyright and other laws of intellectual property.
They are not allowed to be copied, reproduced or modified for any use without the written permission
of Eoptis.

Eoptis and the Eoptis logo are trademarks of Eoptis Srl.

The company names and other product names in this document might be the trademarks and trade
names of their respective owner(s), and are hereby acknowledged.

WEEE

This product should not be treated as household waste. Please ensure that this product is correctly
disposed of, as inappropriate waste handling can cause potential hazards to the environment and
human health.

Made in Italy by

[-]
% tl : ; Sharper vision,
better results.

Eoptis Srl
Via Kufstein, 15 - 38121 Trento (TN) - ltaly
Tel: +39 0461260552
Email: info@eoptis.com
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1 OVERVIEW

Thank you for purchasing the Eoptis' CLM-196, a benchtop tristimulus colorimeter. The CLM-196 is a
compact device for colorimetric detection with a reliability higher than human eye and at a competitive
price. Colour measurements can be performed on the surface of a wide range of matte and glossy
materials, thanks to a (45°c:0°) measurement geometry and the very uniform illumination provided by
integrated LEDs. Long-term stability reduces the need of calibration by the user. The device is powered
and interfaced through a USB port using a standard PC or laptop with a Microsoft Windows operating
system.

After having performed the measurement of the sample of interest, the application software allows you
to:
¢ evaluate the colour difference from a reference patch, to determine whether a sample is within a
user-defined acceptance limit
e classify samples among a set of selected colours, in order to group them in classes with
homogeneous colour and improve uniformity
o find the best match of the sample, looking up a colour database to reproduce the measured
colour.

The colour database is encoded in software, avoiding the use of bulky physical sample libraries. Colour
sets such as RAL are included as standard and a custom or application-specific colour database can
be added by the user or with Eoptis's support on request.

1.1 PACKING LIST

The package contents:

1 CLM-196 colorimeter
1 White reference standard
1 USB stick with software and manuals
1 Certificate of traceable calibration
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2 COLORIMETRY BACKGROUND

This section provides you with useful information about colorimetry and how to get the best results
from the system in real world applications.

2.1 MEASUREMENT GEOMETRY

The CLM-194 colorimeter is designed to measure the samples the way the human eye does in the real
world. It implements a (45°c:0°) geometry, that uses 45° circumferential illumination by means of
multiple directional sources and 0° viewing perpendicular to the sample plane, according to ASTM E
1164. The circumferential illumination is essential to achieve repeatable measurements on directional
and structured surfaces.

The (45°c:0°) instrument is capable of specular excluded (SPEX) readings, that exclude the specular
or gloss component from measurement. The (45°c:0°) geometry simulates the normal condition used
for color evaluation, where a difference in gloss and texture o a sample with same pigmentation results
in a difference in color. A gloss sample is indeed visually judged darker by the eye when compared to
a matte or structured sample.

Several applications require agreement between measurement and visual assessment, therefore
implicitly assuming the (45°c:0°) measurement geometry:

¢ batch to batch comparison in production and quality acceptance

¢ assembly of multi-component products using different materials

e printed materials and the graphic arts industry, where a (45°c:0°) is the conventional
measurement geometry

¢ reproduction of the color of a sample taking into account texture and gloss

e and many others.

If only the pigmentation difference is to be detected or different textures of the same material are to be
compared, a specular included geometry (SPIN) that includes the gloss components in readings is
recommended. This is usually achieved with (d:8°) sphere geometries.

Note that only measurements taken under the same conditions can be compared. Measurements
taken with (45°c:0°) and other geometries match only under a very limited set of conditions and often
exhibit differences of several AE units.

Relevant conditions affecting measurements are:
measurement geometry

illuminant / observer pair

color system

sample preparation and orientation.
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2.2 SAMPLE PREPARATION

An ideal sample to achieve repeatable and accurate color measurements with a reflectance colorimeter

like the CLM-194 has the following characteristics (see also ASTM E1164):

a flat surface

completely opaque with no translucency

clean and dry

uniform across the area being measured

large enough to cover the instrument's sample port

its color is not affected by light (photochromic), moisture (hygrochromic) or heat
(thermochromic)

¢ it adequately represents the material or parts under evaluation.

If any of these qualities is not present, the sample must be made as ideal as possible for a correct
measurement.

Translucency by a non-opaque sample is often the main source of error. Part of the light incident on a
translucent sample penetrates the surface and undergoes internal scattering and lateral diffusion,
which reduces the intensity of reflected light. Ambient light might also penetrate the instrument port
and affect the measurement in an uncontrolled way. A translucent sample must be made as opaque as
possible either by increasing the thickness and/or by backing it with an stable and durable opaque
material (usually black or white). The chosen thickness and baking material should be logged in
measurement report to ensure repeatability.

To select a sample which adequately represents the part under evaluation, examine a sufficient number
of random samples from the lot, and average the readings.

In case of an uneven surface, the instrument optically averages the color on the area corresponding to
the measurement spot. For longer range non-uniformities, it is recommended to average several
measurements taken at different positions on the sample to find the closest match (see the Multiple
Acquisition feature in 4.9.4).

Textured surfaces can be presented to the instrument at any orientation. The circumferential
illumination allows reading which is unaffected by sample orientation. In very limited cases where the
surfaces are highly textured, it is recommended to turn the sample and check differences on multiple
readings.

Several published standards address sample selection for various industries (fibers, yarn, liquids,
powders, coatings, paints, papers, leather, etc...). Contact Eoptis for additional information and support
in identifying the best technique to exploits the full performance of the colorimeter.

Repeatable and accurate measurements may be difficult or impossible to obtain if some samples have
any of the following characteristics:

¢ a surface which contains fluorescent pigments or appears unusually bright

e an appearance which changes based on the point of view (may contain metallic, flake, or
pearlescent colorants)

e avery curved, highly uneven or corrugated surface.
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3 SYSTEM SETUP ON FIRST USE

3.1 RECOMMENDED SYSTEM CONFIGURATION

Windows XP/Vista/Seven/10/11 32(x86) or 64(x64) bits

Intel Pentium 4 2.0 GHz or compatible processor

Graphics card and monitor capable of displaying 1280x1024 resolution at 32-bit color depth
100 MB of free hard disk space

USB2.0 port, with a supply current of 500mA

3.2 DRIVERS AND SOFTWARE INSTALLATION

1) Connect the software USB Software, drivers and third-party packages required by the system
stick are installed by means of the Installer executable, provided on the
USB stick. Automatic detection of the operating system and of any
missing packages is supported.
Launch the "CLM194Setup.exe"” by double-clicking on it and follow
the instructions. The file is not signed by Microsoft and the
Operating System might prompt for approval to proceed. It is
necessary to grant the approval in order to successfully complete
the installation.
The installation sequence is:

- CLM194 application software

- Microsoft .NET Framework (*)

- Micosoft Visual C++ redistributable packages

- Device drivers
(*) installed only if not already present.

2) Plug the USB cable into the At the end of the software and driver setup, plug the USB cable into
host machine’'s USB 2.0 port a free USB port of the PC.

and  confirm successful

installation
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3) Launch
Software

the Application A shortcut of the application software is created on the desktop and

in the Start menu, unless otherwise specified during setup.

Launch the software by double-clicking on the desktop icon.

The green M indicator on the colorimeter will illuminate and the
serial number of the device will be shown in the bottom-left corner
next to the "Device connected” label.
Congratulations, the system is ready for use!

©0 newProject.cpj - CLM-19x Interface - Version 1.35.56.2315 - o x
File System Help
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4

SOFTWARE OPERATIONS

This section explains the software features. The buttons, checkboxes or active items in the user
interface include a pop-up help function which appears when the mouse is held over the item for few

seconds.

41 MA

IN CONTROLS

This section describes the main controls of the user interface.
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Item

Description

Advanced control panel

(1) Measure Acquisition button 1) llluminant/Observer selection

(2) Reference Acquisition button @ Multiple Acquisition control

(3) Undo button (23] Measure/Reference control panel

(#) Operating Mode selector (5) Measure/Reference active indicator

13 Save Report button (6) Color space selector

(4] Output control panel (7) Color coordinates
Color Groups
(9) List of Measures/References
Database control buttons
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The main menu @ on the top of the interface allows you to:

handle Projects see 4.9.3 File->New project | Load project... | Save project...
generate Reports see 4.7 File=>Save report...

perform user calibration see 4.8 System->User calibration

reset user calibration see 4.8 System—>Reset user calibration

reconfigure system see 4.9.8 System->Reconfigure system...

change language System->Language

set preferences see 4.9.6 System - Preferences...

get system information Help->About

The main toolbar @) features three pushbuttons that allow you to:

D Acquire Measure data
@ Acquire Reference data
©) Undo the last operation

The four central icons (3) switch between the various operating modes featuring the following
functions:

Color Difference Check see 4.3
Color Matching see 4.4
Color Classification see 4.5
L*a*b* Chart see 4.6

The central Output control panel @ changes according to the selected operating mode function and
shows specific controls and outputs, as described in the relevant sections.

The Measure and Reference control panels @ @ include all the controls needed to perform and
manage the color data acquisition. Each acquisition can be either addressed as a Measure or a
Reference depending on its expected usage. Measure and Reference data are indeed handled in
different ways depending on the selected operating mode function, as described in 4.3 to 4.6. It is
possible to exchange previously acquired Measures and References, as described in 4.9.1.

The Measure and Reference Modes is highlighted (5) on the panel once a color is acquired and the data
is added to the list of the highlighted section. In both cases, each acquired color will be added to the
Default Group of the Color List (9). The last acquired color will become the current color, used as
input by the operating mode functions, and its coordinates will be displayed (7) in units according to
the selected color space (6). The user can select a previously acquired color by double clicking on it in
the list or by dragging it to the corresponding Display Area in the Output control panel.

The Measure and Reference Lists can be managed by means of the Database Control buttons (0), as
described in 4.9.1.

The Save Report button 13 allows you to save a report of the current measures and analysis results in
.pdf and Excel-readable .xml formats. See 4.7 for details.

The Advanced Control panel @ includes:

@) Multiple Acquisition control, to average a sample see 4.9.4
©@ llluminant and Observer controls see 4.9.5
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4.2 MEASURE AND REFERENCE ACQUISITION

The acquisition of Measure and Reference color data is performed through these steps:

1. Connect the device

2.Launch the software

3.Ensure that the sample to be acquired has the characteristics listed in the section, 2.2

4.Ensure that the device's glass window is clean, otherwise follow the instructions in 6.1.

5. Place the colorimeter's measurement aperture in perfect contact with the sample surface

6. Trigger the acquisition clicking the Measure or Reference acquisition button

7. Wait for the new measure value to displayed on the software interface

8. Select the desired Operating Mode function and configure its options to analyse the acquired data.

If required, the system allows you to average multiple acquisitions. This feature is useful in the case of
samples with uneven or structured surfaces. See 4.9.4 for details.
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4.3 COLOR DIFFERENCE CHECK

The Color Difference Check function performs a fast check of the color difference

between the Measure and the Reference colors, a group of Reference colors or the
entire Reference database, providing a quantification of the CIE 1976 a,b color
difference (CIELAB) AE*.,. Measure is ranked according to threshold levels set by user,

allowing to definition of acceptance or rejection criteria based on objective elements.
The result can be used for the quality control of a product, to evaluate the color aging
of an object and for many other applications.
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Color Difference Check interface

Item

PECEERN @E®EWEE

Description

Color Difference Check mode selector

Measure color display area

Reference color display area

Reference Mode selector

CIELAB AE*,, color difference between Measure and Reference

CIELAB AL* lightness difference, CIELAB AC*., chroma difference, Aa* and Ab* components
difference between Measure and Reference

Acceptance Thresholds values for AE*a, color difference

Visual representation of the AE*a, color difference compared to the Acceptance Thresholds
Acceptance threshold validation result

Acceptance class (rank) of the current Measure

Plot of the current Measure in the L*a*b* color space with Reference set at the origin of axes.
Open Color Check settings panel
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4.3.1 HOW TO PERFORM A COLOR DIFFERENCE CHECK ANALYSIS

1. Select the Color Difference Check function from the Operating Mode selector

2. Select and setup the Color Check mode from the Color Check settings panel 12)

3. Acquire a desired Reference sample. Either select an existing sample from the References list
or let the software detect the closest to Measure, belonging to the selected group of the
Reference list

4. Acquire the data of the Measure sample under evaluation. If acquisition has already been
performed, any color in the Measure list can be selected by double-clicking on it

5. The software performs the color difference calculation and shows the results of acceptance
threshold validation and plots the CIE L*a*b* Measure coordinates against the Reference ones

4.3.2 COLOR CHECK ANALYSIS MODES

Color Check analysis works in Classes mode or in Thresholds mode. The mode and parametrization is
done via the Color Check settings panel (2. The analysis results are displayed in a different way, given
the mode selected.

Classes mode

X

Color Check mode
O Classes
() Thresholds

Classes mode settings

Classes thresholds
TH1 THZ TH3

dE‘ab 1.0 <120 < (3.0 =

© Claszesrange () Coordinates range

Graph range

Range 1dE; 1.0 =
Range 2 dE: 20 =
Range 3 dE: 3.0 =
QK Cancel

In Classes mode, the software will compute the distance between the current measure and reference
colors, and puts the measure in a given “quality class” given the set classes thresholds. The measure
can fall in 3 classes, or be out of threshold.

- - - *, -
MEASURE P PR 95 20 18 REFERENCE
Color Info:  CIE L'ab* ~ % vy vy % MANUAL ~ | ColorInfo:  CIE L*a'b* v
L 69.62 MSR 0019 REF 0024 L 69.38
an 254 a® -356
b*: 37.33 b*: 3917

Given the selection in the Preferences Panel (see 4.9.6) the user can select to display the results graph
in two ways:
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e Classes range: controls the dE ranges for the CIE L*a*b* color check graph

dE: 0.94
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e Coordinates range: controls the single coordinates ranges displayed when the color check chart
is displayed in the current color space (different from CIE L*a*b*)

1.00 3 [200 /2] dE: 0.94
026 dr03%
n dz:082

v v v h MANUAL a2

55 1 55 1L 55 1
—
X > N
o b ] o

It also possible to show the L*a*b* chart (see also 4.6).
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Threshold mode

Color Check mode
() Classes

© Thresholds

Threshold mode settings

Range 1 Range 2

TH1 TH2 TH3
Ref: dEab -~ NONE -~ MNONE -~
Min: (0.0 < ||0.0 0.0
Max: 2.0 <||0.0 0.0
Range 1dE: 20 =
Range 2 dE: 40 =

QK Cancel

In Thresholds mode the user can setup two acceptance ranges, each defined by up to three thresholds
on various quantities. The user can define limits for the various measure/reference distances (e.g. -2
< dL* < 2 and dE*ab < 3); the software will signal if any of the quantities exceeds the threshold. A range
of values can be defined for the measure's coordinates (e.g. 80 < L* < 85), without comparing itto a
reference; again, the software will signal when the selected cordinates’ ranges are exceeded. The
quantities used for the analysis are highlighted in the main interface; when a quantity exceeds its range
it will be displayed in red; otherwise in green.

dE*ab: 1.86

MEASURE . . dLS026  dan 001 REFERENCE
dc183  dbt-184

Color Info:  CIE L"ab* “ o e % MANUAL ~ | Colorinfo:  CIE L'ah* ~

L 69.62 MSR 0019 REF 0024 L 69.38
o 254 as -3.56
b*: 3733 b*: 3517

To display info on the Chroma and Lightness plot (see 4.3.4), based on measure/reference dE*ab, the
user can select two dE*ab ranges, even when this quantity isn't selected for any range.
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4.3.3 USING THE INTERFACE

will appear to be different from the actual color of the sample. This is due to several
factors (such as the ambient light, monitor calibration, gamma settings, ...) which
must be controlled and fine tuned in order for the colors to match.

; The acquired color is displayed on the monitor as a guide only. It is very likely that it
[ ]

The Reference can be selected in two different ways, using the Reference Mode selector (4).

Manual mode. Manual mode is enabled by selecting the MANUAL option in the Reference Mode
selector (4). In Manual mode, the user selects a color from the Reference List by double-clicking
on it, by dragging it to the Reference color display area (3), or by acquiring a new Reference color.
Manual mode allows the color difference of the current Measure (either that just acquired or
selected from the Measure list) to be evaluated with respect to a Reference which is fixed and
does not change during operations.

Automatic mode In automatic mode the software automatically chooses the Reference color
selecting the most similar (lower AE*;,) to the current Measure. If the ALL option is selected in
the Reference Mode selector (4), the color will be chosen among all colors in the Reference list.
If the corresponding group name is selected, a color group will be chosen. Automatic mode
allows the user to highly speed up the Color Difference Check when a large set of samples
comprised of a subset of various colors is to be checked. The user does not need to select the
right Reference when a new sample is being acquired since the software automatically detects
it. The automatic selection process is effective even on very similar colors if a group of Reference
colors to be selected is specifically built and the AE*,, difference between these colors is larger
than the highest Acceptance Threshold.

The software displays the color difference between Measure and Reference following the formula used
in the CIE 1976 a,b (CIELAB) AE*,, color difference (5); the same formula for color difference is used
for other color spaces, using the relative color space’s coordinates. Single components differences, as
well as chroma difference, are also provided (6).

AE*ab=\/(|-*1 — %)% + (@*; —a*y)? + (b*; — b*;)?

Ac*ab=\/(a *1)2 + (b *1)? — \/(a %0)2 + (b *¢)?
AL*=L*; — L%, Na*=a*; —a*, ; Ab*=b*; — b*,
being (L*;; a*y; b*1) the Measure coordinates and (L*o; a*o; b*o) the Reference coordinates.

Note that not all color spaces have chroma info available, and not all color spaces have 3 coordinates
(e.g., see 4.9.7 Custom color spaces).

The color differences will be used to perform the analysis. Classes mode will always use the colors’
distance. Threshold mode will use the selected differences/coordinates.

4.3.4 CHROMA AND LIGHTNESS PLOT

The Chroma and Lightness plots (1) show the Measure coordinates, plotted against the Reference
coordinates set at the origin of axes. Also the three Acceptance Thresholds are displayed as boundaries
in these plots. The graphs and the colored ticks (Red/Green for a*, Yellow/Blue for b*, Black/White for
L*) help the user to understand which component is the prevalent source of color difference between
Measure and Reference.

See also 4.3.2 for details regarding the plot display modes.
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4.4 COLORMATCHING

L-

Given a current Measure, the Color Matching function displays the 5 most similar
colors, looking up the References list or a subset of it. A proprietary or standard
database (RAL classic and RAL design) can be used as the Reference list. The closest
matching colors are ranked by increasing CIELAB color difference with respect to the
current Measure. This information can be used to select the color that resembles the
measured sample by simply checking a best-candidate color palette instead of looking
up a large set of physical samples.

File System Help

QCOKNE VI

MEASURE

Color Info:  CIE L"ab"

69.26

Color Matching interface

Item
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a Device connected: 24290019

brown o

default group
brown

eoptis

REFERENCE

Color Info:  CIE L*ab* e
L3 9253

e 079
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broun

lluminant D50 -~ Observer 10° ~

Muttiple D

[0 REF 0030

™ REF 0027
I REF
default group |

REF 0031

OOOO O

Description

Color Matching mode selector
Measure color display area
Reference color display area (up to 5)

Reference rank

Color ID
CIELAB color distance between Measure and Reference
Reference group selector for best match look-up
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4.41 HOW TO PERFORM A COLOR MATCHING ANALYSIS

1. Select the Color Matching function from the Operating Mode selector

2. Select a group from the Reference group selector.

3. Acquire the data of the Measure sample to match. If acquisition has already been performed,
any color in the Measure list can be used by double-clicking on it.

4. The best matching candidates will be shown.

4.4.2 USING THE INTERFACE

will appear to be different from the actual color of the sample. This is due to several
factors (such as the ambient light, monitor calibration, gamma settings, ...) which
must be controlled and fine tuned in order for the colors to match.

: The acquired color is displayed on monitor the as a guide only. It is very likely that it
[ ]

The Color Matching function shows the References ranked according to the CIELAB difference of each
Reference with respect to the current Measure. The search will be performed among colors belonging
to the group selected by the Reference group selector (7). To search all colors from the Reference list,
select the ALL option. More info about the management of color groups can be found in 4.9.2.

Eoptis srl Page 20 of 36
CLM 196

Rev.1.10 - 03/2025

Copyright © 2025



I CLM 196
%ptls User Guide

4.5 COLOR CLASSIFICATION

The Color Classification allows the user to select up to 5 colors and check which is the
most similar to a measured sample. This is useful when sorting products with similar
._E but slightly different colors or when assigning an object to a batch of homogenous

colors, using the color as classification parameter. Samples can be grouped into sets
with a color shift towards the same direction (lighter, darker, greenish, bluish, reddish)
and therefore improve color homogeinity by reducing the color difference among
samples of the same set. With this feature, sorting and classification processes
become much more reliable and accurate than visual inspection.

File System Help
1 e® .
O- -~ v coptis
@ ‘@‘ ‘2 """E e !
THMAX [5.0 ] 7
MEASURE Bk REFERENCE Q
Color Info:  CIE L*a'b" w Color Info:  CIE L*ab* ~
2 i 6325 L 6898
a 1.89 a* 258
b 3737 b 1019
NAME NAME
brown brown 6
I wsR 0022 [ REF 0030
0 msr o020 I REF 0027
MSR 0019 REF 0023 . [ REF 0024
[ wsr oos default group
red REF 0031
I VSR 0005 REF 0029 |
default group W
B visR 0028 REF 005
WSR 0021 REF 0023
Bl vsRom7
B vsr o016 3
Bl vsr 0015
[ msroms T
[ wsm o013 \
B wsr o012 —
MSR 0011
Il vsr o010
B wsr oona
|E%I f Y nn lluminat D50 - Obseer 10° Mutiple 0O % f $ nn
a Device connected: 24290019 _

Color Classification interface

Item Description
(1)  Color Classification Mode selector
©) Measure color display area
(3)  Reference color display area
(#4)  AE*, color difference between Measure and Reference
(5)  Color Remove button
(6)  Classification Result indicator
(7  Maximum Threshold
Eoptis srl Page 21 of 36

CLM 196
Rev.1.10 - 03/2025
Copyright © 2025



I CLM 196
c%)F)tls User Guide

4.5.1 HOW TO PERFORM A COLOR CLASSIFICATION ANALYSIS

1. Select the Color Classification function from the Operating Mode selector

2. Select up to 5 colors to be used as class identifiers from the References list by dragging them
in the Reference color display area

3. Set a Maximum Threshold value. This prevents a Measure which exceeds a specified color
difference.

4. Acquire the data of the Measure sample under evaluation. If acquisition has already been
performed, any color in the Measure list can be used by double-clicking on it.

5. Verify which class the sample has been assigned to.

4.5.2 USING THE INTERFACE

The acquired color is displayed on the monitor as a guide only. It is very likely that it
i ' S will appear to be different from the actual color of the sample. This is due to several
[ ]

factors (such as the ambient light, monitor calibration, gamma settings, ...) which
must be controlled and fine tuned for the colors to match.

In the Color Classification interface, the user can select up to 5 colors from the References list. The
selection can be made by dragging the colors from the References list to one of the five sections in the
Reference color display area (3). These colors will set the classes to which the measured sample may
belong. The colors can be removed by clicking on the remove button (5).

Once a Measure is available (either just acquired or selected by double-clicking in the Measure list),
the Color Classification engine will identify the class to which the Measure belongs and place the
Classification Result indicator (6) next to the corresponding Reference color. The AE*,, difference
between the Measure and each Reference is also shown (4).

If the difference between the Measure and all the classes exceeds the set maximum threshold (7), the
Measure is not assigned to any class. In this case the classification result indicator is removed and an
‘X" icon will be displayed next to the Maximum Threshold selector (7).
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4.6 L*A*B* CHART

File System Help

QCOKNE Vs
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L*

The L*a*b* chart displays all the colors in the Measure list on a graphical
representation of the CIELAB color space. This provides the user with visual
information about where the sample lie in the color space.

eoptis
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Color Info:  CIE L"ab* ¥
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b 10.19
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[ REF 0030
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a Device connected: 24290019
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Muttiple

CIE L*a*b* interface

Item

Description

(1)  CIE L*a*b* Chart Mode selector
(2)  Chromaticity plot (a*, b*)

(3  Lightness plot (L*)
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4.7 REPORT GENERATION

The software can generate a report of the data in the Measure list by clicking the Save Report button
(1) or accessing the menu option “File>Save report...”. The report can be saved in PDF or XML format.

OO NE v ! iefils optis

080 2] (200 2] [490 (2] AE*ab: 1,32

MEASURE  mm B3 L B

The PDF report shows the name and the actual color of each measured sample, as well as the CIELAB
coordinates and other relevant information related to the selected analysis feature. All data are sorted
by groups. If a note is added to the color, it will also be printed on the PDF. A user logo will be printed
at the top of the report. To customise the printed logo, replace the file "UserLogo.png" in the software
executable folder with an image file with the same name and format; this file will be automatically loaded
during report generation. The recommended size is 277x165 (other sizes will be rescaled).

The XML format Is meant to be used for off-line analysis purposes. The file can be opened with a
spreadsheet program (such as MS Excel, LibreOffice Calc, ...), so the included data can be used to
analyse the acquired data. For each entry, the report displays the color name, the CIELAB coordinates,
the group, any note added by the user and date/time information and other relevant information related
to the selected analysis feature.
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4.8 USER CALIBRATION

Each colorimeter is supplied with its own white reference standard, necessary to perform the user
calibration. The standard is manufactured from highly stable materials and labelled with a unique serial
number. Ensure that the colorimeter is used with its matching white reference standard and that the
serial numbers match, otherwise calibration will lead to unpredictable results that may compromise
system accuracy. The software prompts for calibration when necessary. Before proceeding with the
creation of a database, it is recommended to calibrate the system using the white reference standard.

To perform the calibration:
1. Ensure the standard is clean otherwise clean it with a moist cloth. Do not use acetone or alcohol.
2.Access the calibration panel on the “System-User calibration” software menu.
3.White target: apply the measurement aperture of the colorimeter to the White Calibration
Standard and click the MEASURE button on the dialog box.
4.Dark: dark calibration can be skipped for this device. Press the X close button on the White
Balance window after the white target acquisition.

Step 3. Acquisition of White Calibration standard

Reset user calibration

If the measures look wrong after an user calibration, it is possible that the procedure failed due to target
coupling or other factors. Repeat the procedure to fix the error.

If the measures continue to look wrong, the user can restore the factory calibration from the menu
“"System->Reset user calibration”.
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4.9 ADVANCED FEATURES
4.9.1 DATABASE MANAGEMENT

The colors acquired and added to the Measures and References lists are organized in databases. In
this way, the colors lists can be saved/loaded for future use. Note that the Measures and References
databases are fully interchangeable, so one can choose to use a Measures database as a References
database (and vice versa) when performing analysis.

The colors are added to the database when performing an acquisition; they can then removed by right-
clicking on a color in the list and selecting “Remove item”. From this same menu one can also add notes
to the color and rename it.

All colors in a database are organised in groups. There will always be a "default group”, while other
groups are user defined; the maximum allowed number of user defined groups is 15. Every newly
acquired sample will be added to the default group. For more info about groups management, see
4.9.2.

The groups of the Measures list are used mainly to organise the colors, while groups in the References
list can be used to filter the results in Color Difference Check and Color Matching functions. The
Database Control buttons can be used to manage the software's current databases as well as
previously stored databases.

= = ﬁ
— 0 =y l._.l
Database control buttons
Item Description

(1)  Create new database
(2)  Merge databases

(3)  Load database

(#)  Save database

(5)  Lock/Unlock database

The Create new database button (1) removes all colors from the list so you can start with an empty
database.
The Merge databases button (2) allows you to merge a previously saved database with the current
database; all the colors and groups in the saved database will be added to the current database.
With the Load database button (3) you can load a previously saved database, removing all current
colors.
The Save database button (4) allows ypu to save a database on the computer for future use. Files can
be saved in .cdb (proprietary), in .pdf and .xml (Excel readable) format. The following flags can be
adding to the database when saving:
¢ Isread only: the database becomes a read-only; no colors or colors grup can be added, removed
or updated, as well as color groups. This is a "soft” lock that can be removed with the
Lock/Unlock database button
e Has hidden coordinates: the colors coordinates are hidden; only the color name can be seen by
the user. This flag can be used to release a proprietary database without sharing sensitive data
about the colors. Note that this flag, once set, can't be removed.
The Lock/Unlock database button (5) allows you to toggle the read-only mode for the database. This
can be used to prevent database modification during color analysis.
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4.9.2 DATABASE CONTEXT MENU

A context menu, displayed by right-clicking on the colors list, allows the user to perfom several actions
on single and multiple colors, as well as on the whole database.

Rename item...
Add notes...
Save analysis report...

Delete itern

Add to group 3
Edit group name...

Remove group

Move to References b

Copy to References 3

Average selected colors

Search...
Find next F3
Sort databaze 3

Save on reference file...

¢ Rename item...: change name of the selected color
e Add notes...: add notes to the selected color for future reference
e Saveanalysisreport...: (only for Measures database) save report only for the selected measures
e Delete item: remove the selected color(s) from the database
o The action can be done without accessing the context menu by selecting the desired
color(s) and pressing Canc or Backspace key
e Add to group: the selected color(s) will be added to one of the existing listed group, or a new
group can be created (“New group..." option)
o Edit group name...: change the name of the group that the selecter color belongs to
¢ Remove group: remove the color's group from the database. All the colors belonging to this
group will be moved to “default group”
e Moveto ReferenceslMeasures: move the selected colors in a given group in the other database,
removing them from the current database
e Copyto References|Measures: copy the selected colors in a given group in the other database
e Average selected colors: generates a new color with coordinates set to the average coordinates
of the selected colors
o NOTE: the average will be performed on the coordinates of the currently selected Color
space (e.g. CIE L*a*b*); due to the non-linear nature of color spaces transformations,
the new color's coordinates can differ from the average in color spaces diferrent form
the currently selected one
e Search...: search a color in the database that contains a given string
¢ Find next: find the next item in the database that satisfies the search request
o The action can be done without accessing the context menu by pressing the F3 key
when the desired database is selected (any color on the database is selected)
e Sort database: sort the database by color name or by color acquisition date
o The database will be sorted alternately ascending and descending
e Saveonreferencefile...: save the selcted color as a reference file for CLM195 Interface software
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4.9.3 PROJECT MANAGEMENT

The “File"” list in the software main menu is used to manage projects. The software treates each
program session as a project that cointains all relevant information about the Measures and References
databases, including analysis parameters. With this feature you can save the current session and
resume a previously saved one.

When loading a previously saved project or creating a new project, the current database entries and
analysis parameters are replaced by the saved data or deleted.

4.9.4 MULTIPLE ACQUISITION

Multiple Acquisition should always be performed in cases of uneven or structured surfaces. The
advantage of Multiple Acquisition is that the visual evaluation is supplemented by the calculation of a
mean for the measured values. The Mutiple Acquisition feature is enabled by specifying the number of
measurements to be averaged and by thicking the corresponding checkbox.
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Continuous measure

When multiple acquisition is enabled, the user can enable and start Continuous measure. Once started,
the software will automatically acquire all the multiple measures needed to generate the final average
measure, with a delay of 2 seconds between each acquisition.

File  Systern  Help

POV

SUMEENE L 1.00 |2 [230 | [5.00 |2
Continuous measure 1 1 1

Color Info:  |CIE L"a'b" W * \;' \If
L": 69.26 MSR 0019
a” 1.89
b 3737

4.9.5 ILLUMINANT-OBSERVER PAIR SELECTION

The interface's Advanced control panel allows the user to set the Measure llluminant (Sl) and Observer
(SO) pair. The following options are available and can be selected in any (SI;SO) combination. The
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selected combination is automatically saved for future software sessions, when it will be restored and

used as defaul
llluminant
D65 (*)

D55
D50
A(*)
C
FL2
FL7

FLT

t settings.
Notes

Noon daylight (reference for sRGB color
space)

Mid-morning daylight

Horizon light

Incandescent / tungsten

North sky daylight

Cool white fluorescent

Broadband fluorescent, D65 daylight
simulator

Narrow band fluorescent Philips TL84,
Ultralume 40

(*) CIE standard illuminant

Observer

CIE 1931 2° standard colorimetric observer

CIE 1964 10°

standard colorimetric observer

6500K

5500K
5000K
2850K
6800K
4230K
6500K

4000K

Approximate correlated color temperature

Performance specifications refer to (D65; 2°) pair, which is the recommended setting to be used
whenever possible.

[RNTRRTTITN

MSR D015
MSR 0014
MSR 0013
MSR 0012

MSR D011

MSR 0010
MSR 00Ng

55

ositivo connesso: 24280019

lluminante Osservatore 107
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4.9.6 PREFERENCES PANEL

Preferences Panel

Color Check graph preferences
Always display Color Check graph in CIE L"a"b" color space

[ Display CIE L"a"b" color space graph in Color Check tab

Cancel

From the preferences panel the user can configure some extra options for the color analysis modes.

Color Check
The user can select the format of the Color Check graph.

e Always display Color Check graph in CIE L*a*b* color space: if checked, the graph will be
displayed in CIE L*a*b* color space regardless of the currently selected color space. If not
checked, the single coordinates' delta is displayed.

e Display CIE L*a*b* color space graph in Color Check tab: if checked, a copy of the L*a*b* chart
from the relative tab will be displayed in the Color Check tab. The user can select which part of
the chart to display.

See 4.3.2 for further details.

4.9.7 CUSTOM COLOR SPACES

The software manages various standard color spaces (CIE-XYZ, CIE-xyY, CIE-L*a*b*, ...). It is possible
to add further user-defined color spaces and perform analysis on them.

The coordinates of the custom color spaces are computed by applying user-defined mathematical
operations on the coordinates of a given source standard color space. The formulas, as well as other
color space's parameters (the new color space’s name, coordinates’ names, ...) will be defined in a text
file that must be saved in the folder

C:\Users\Public\Documents\EOPTIS\CLM19x Software Suitel\ini\customColorSpaces

An example file README.ini is provided; all instructions to generate new files and edit the parameters
are described in said file.

All custom color spaces' files will be parsed by the software CLM19x Interface at startup. Custom color
spaces can be selected from the Color space selector (see 4.1 Main Controls) as any other standard
color space.

4.9.8 ACCESS SYSTEM MEMORY

The user can upload system memory files (*.cIm) on the device. This features useful when multiple
field of views adapters are used. When switching to a new field of view adapter, the user must upload
the corresponding memory file to ensure correct color readings.
To upload a memory file:

1. Open the panel from System->Reconfigure system...

2.Press "“Load file..." button and select the correct .clm file

3.Press "Apply"” to load the data

It is also possible to download current memory data, that EOPTIS can use to debug any major
measurement problem, using the menu System->Download system data...
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5 TECHNICAL SPECIFICATIONS

Item

Instrument class
Sensor type

Measurement mode
Acquisition mode

Working distance
Measurement geometry

Light source
Color scales

Color differences
luminant

Observer

Short-term repeatability

[llumination/Measurement area
Size of smallest measurable
specimen

Measurement time
Recommended warm-up time
Dimensions

Weight

Interface

Power requirements

Operating ambient temperature
Storage temperature

Humidity range

Protection rating

Usage

Standards traceability

Standard accessories (Packing list)

Description

Tristimulus colorimeter

Color sensor based on the standard spectral value of the CIE
1931 color matching functions as per DIN ISO 13655 and DIN
5033

Reflective

Software-triggered

Single or multiple readings

Contact

Circumferential 45° illumination and 0° viewing, according to
CIE15:2004, ASTM ET1164

16 LEDs

CIE-XYZ, CIE-xyY, CIE-L*a*b*, CIE-L*C*h*, CIE-L*u*v*, sSRGB
(where applicable), user-defined

AE*a (CIE 1976), AC*ap, AL*, Aa*, Ab*

D65, D55, D50, A, C, FL2, FL7, FLT

CIE1931-2° and CIE1964-10° standard colorimetric observers
0.03AE*a typ — D65/2°, standard deviation of 30 measurements
every 5 s on white reference standard under Eoptis standard
conditions (*)

@10mm /@18mm

@23mm flat surface

<0.1s, with 5 s minimum recommended measurement interval
20 minutes

Approx. 120 mm (L) x 84 mm (H) x 90 mm (W) excluding cable
Approx. 710 g

USB 2.0, 500 mA rated

USB self-powered, 2.5 W peak, 0.6 W typical

10 °Cto 40 °C 50 °F to 104 °F

0°Cto60°C 40 °F to 140 °F
20-80% RH non-condensing

P54

Indoor use

Instrument standard assignment in accordance with National
Institute of Standards and Technology (NIST) following
practices described in CIE Publication 44 and ASTM E259
(Standard Practice for Preparation of Pressed Powder White
Reflectance Factor Transfer Standards for Hemispherical and
Bi-Directional Geometries)

- White reference standard

- User guide

- PC utilities disk and interface drivers

- Certificate of traceable calibration (if ordered)
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Main Software features

Data view

Software language

(*) 25°C,50% RH, 20' warm-up

- Check: Pass/fail with thresholds and automatic look-up of
reference color

- Match: Search for closest standard in pre-loaded or custom
database

- Classify: Classification under selected standards

- Average multiple readings

- Data import/export to proprietary database

- Data export to .pdf and Excel-readable . xml format

- Generation of analysis report in .pdf and Excel-readable . xml
format

Note: availability of some features may vary by version

- Color Data (see available scales above)

- Color Difference Data (see color differences indexes above)

- CIE-L*a*b* Color Plot

English, ltalian (ltaliano), Chinese (#13X), Portugues (Portugues),
French (Francais)

Specifications subject to change without notice.
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6 APPENDICES

6.1 PRECAUTIONS AND SYSTEM MAINTENANCE

When handling the colorimeter, avoid touching the glass window. The window is recessed and
therefore protected from dirt during normal usage. However, if it does require cleaning:

e at first, blow short bursts of clean, dry air onto the window

o if dirt has not been removed, use an optical lint-free cloth dampened with distilled water and
gently wipe the window without applying excessive force

e in the case of a very soiled surface, contact Eoptis for support.

Occasionally wipe the outside of the meter with a soft water-dampened cloth. The housing components
are made out of synthetic materials. Thus, avoid contact with acetone and similar detergents that
contain solvents. Remove any splashes immediately.

The device is designed for indoor use. Extended exposure to bright sunlight, rain, dusty environments,
etc. may damage the electronics and the optics of the system. Avoid excessive shaking, dropping or
mishandling of the device.

6.2 TROUBLESHOOTING

Problem
The usb cable is plugged but software displays “Device not connected.
Solutions
1) Thedrivers are not correctly installed: check proper driver installation section and, in case
the CLM194 is not displayed, install drivers. To check the Device Manager to confirm that
installation was successful, go to the Windows Start menu, select Run and enter
“"devmgmt.msc”. You will find the "CLM-194 Colorimeter” under the “Ports (COM & LPT)"
section.
2) The USB port is not capable of supplying full current (500mA): change port or disconnect
USB devices (such as external hard drives and speakers) which are connected to other
ports.
3) Operating condition undefined or excessive EMC load: unplug and reconnect the USB
cable, then re-start the software.
4) A system error initial: re-start software and re-connect the cable.

Problem
The color displayed on the screen differs from the color of the sample.

Solutions
This is not a malfunction. The measured color is displayed on the monitor as a guide only.
Differences are common and it is very likely that the measured color will appear to be different
from the color of the sample. This is due to several factors (such as the ambient light, monitor
calibration, gamma settings) which must be controlled and fine tuned in order for the colors to
match. Contact Eoptis to check how your PC can be tuned to improve matching.

Problem
The measured color data are obviously incorrect.
Solutions
1) Ensure the sample perfectly adheres to the measurement port.
2) Ensure the sample and the glass window of the measurement port are clean.
3) Check that the units is within its operating temperature range.
4) Perform a user calibration using the white reference standard.
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6.3 STANDARDS
CIE15:2004 General terminology of colorimetry and basic data

DIN 5033 Colorimetry; basic concepts

DIN 5036 Radiometric and photometric properties of materials; definitions
characteristics

DIN 6174 Colorimetric evaluation of color differences of surface colors according to the
CIELAB formula

ASTM D2244 Standard Test Method for Calculation of Color Differences from Instrumentally
Measured Color Coordinates

ASTM E308 Standard Practice for Computing the Colors of Objects by Using the CIE
System

ASTM ET1164 Standard Practice for Obtaining Spectrophotometric Data for Object-Color
Evaluation

6.4 WARRANTY AND REPAIR

Eoptis warrants to the Original Purchaser that the product provided with this package is guaranteed to
be free from material and manufacturing defects for a period of one (1) year from shipment date. Should
a unit fail during this period, Eoptis will, at its option, repair or replace the damaged unit. Repaired or
replaced units will be covered for the remainder of the original equipment warranty period. This
warranty does not apply to units that, after being examined by Eoptis, have been found to have failed
due to customer abuse, mishandling, alteration, improper installation or negligence or are beyond
reasonable reparability. Warranty is void if any proprietary labeling is removed.

Eoptis expressly disclaims and excludes all other warranties, express, implied and statutory, including,
but without limitation, warranty of merchantability and fitness for a particular application or purpose. In
no event shall Eoptis be liable to the Original Purchaser or any third party for direct, indirect, incidental,
consequential, special or accidental damages, including without limitation damages for business
interruption, loss of profits, revenue, data or bodily injury or death.

Products within the warranty period may be returned for repair. Outside the warranty period, products
may still be returned for repair; however, a fee will be charged. The customer is responsible for shipping
costs to and from Eoptis.

An RMA number is required before an Eoptis product can be returned. Products that are returned
without an RMA number may be refused and returned to the sender, or may result in unnecessary
processing delays. An RMA number and repair service may be requested via info@eoptis.com.
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7 REVISION HISTORY

Version Date Description
Rev.0.9  08.2013 Preliminary release
Rev.0.10 09.2013 Software functions description added
Rev.0.11  09.2013 Advanced features added
Rev.1.0 09.2013 Initial full release
Rev.1.01  09.2013 Minor corrections
Rev.1.02 12.2013 Setup procedure updated, additional llluminant and Observer pairs supported
Rev.1.03  12.2013 Minor updates
Rev.1.04 03.2014 Table of specs added.
Upgrade for software Rel.1.3.2:
- report features added
database can be saved in .pdf and .xml format.
Rev.1.05 06.2014 English language corrections.
Upgrade for software Rel. 1.3.5:
(SI;SO) pair is saved and restored at new software session.
Rev.1.06 12.2014 User Calibration procedure updated with Dark acquisition.
Rev.1.07 02.2022 Added description of Database context menu
Rev.1.08 04.2022 Described USB stick installation
Rev.1.09 10.2022 Description of function Color Check; Thresholds mode
Description of user-defined color spaces usage
General revision
Rev.110  03.2025 Rebranding
Added "Copy/Move to other database” context menu notes
Added "Preferences panel” description
Updated screenshots to last version
Aligned some procedures for CLM196 functionalities
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